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How to use this document 

This document gives you brief instructions to set up the Paul Coverdell National Acute Stroke Program (PCNASP) 
Data Collection Tool within Epi Info™ 7. This quick start user guide should not be used as a complete user guide to 
Epi Info™ 7. Epi Info™ is a powerful tool with a suite of modules and tools to collect, analyze, and manage data. 
For the complete Epi Info™ User Guide, visit https://www.cdc.gov/epiinfo/support/userguide.html.  

This user guide covers the following instructions (navigation links): 
1. Downloading the Epi Info™ software
2. Download and set up of the PCNASP Data Collection Forms
3. How to enter data in Epi Info™
4. How to save a page or record
5. How to view a data table
6. How to use Find to search for records and update records

Downloading the Epi Info™ software 

Follow this link to download Epi Info™: https://www.cdc.gov/epiinfo/pc.html 

System Requirements 
• Microsoft Windows XP or above
• Microsoft .NET Framework 4.0 or above
• Recommended: 1 GHz processor
• Recommended: 256 MB RAM

NOTES 
Epi Info™ 7 may be downloaded in two different formats: as a ZIP or a setup file. The following explains 
what scenarios may be best suited for each format. 

ZIP (.zip file) Installation 
• Can be downloaded to most user desktops and run without requiring administrative or elevated

privileges.
• Can be extracted to and run from any folder on which the user has read/write/execute privileges

(including thumb drives).
• Assumes that the machine already has Microsoft .NET 4.0 and other prerequisites installed.
• Recommended for disconnected laptops and other emergency use if IT support or infrastructure

is unavailable.

Setup Installation (.msi file) 
• Traditional setup mechanism that deploys Epi Info™ 7 to the location required by IT policy.
• Allows network administrators to centrally manage and push Epi Info™ 7, including updates and

patches, to users using Microsoft System Center Configuration Manager.
• Ensures that the machine’s configuration matches the software’s minimum requirements.
• Pre-compiles and registers Epi Info™ 7 components on the machine, enabling certain components to

run faster.
• Requires administrative or elevated privileges during installation.

P  a  g e |  1

https://www.cdc.gov/epiinfo/support/userguide.html
https://www.cdc.gov/epiinfo/pc.html


• Recommended for centrally managed IT environments.

Helpful links for additional assistance 
Epi Info™ User Guide: https://www.cdc.gov/epiinfo/support/userguide.html  
Support and Resources: https://www.cdc.gov/epiinfo/support.html  
Frequently Asked Questions: https://www.cdc.gov/epiinfo/support/faqs.html 
Help Desk: https://www.cdc.gov/epiinfo/support/helpdesk.html  

Downloading the PCNASP data collection forms 

After installing the Epi Info™ 7 software, you are ready to download and begin setting up the PCNASP data 
collection forms. A few things to note about Epi Info™ 7 and the PCNASP files available to set up a data collection 
tool:

• 

• This initial setup includes an Extensible Markup Language (XML) file that Epi Info™ refers to as a template. 
Templates allow users to package all features and information of an already developed project, form, 
page, or group of fields in an XML format. This then provides a shareable file ready to be used by any 
number of users without sharing collected data. As mentioned, you will use an XML file to create the 
PCNASP data collection forms. 

• Once this template file creates a new project in the Form Designer of Epi Info™, it is advised that you not
make changes to the fields, pages, or forms. If any changes are necessary, it is best to familiarize yourself
with Epi Info™ by reading the Epi Info™ User Guide. Please note that once you begin entering data, you
will not be able to make certain edits to fields in the project.

- The project file you will download contains three forms to collect data: The in-hospital form and
nested within are the pre-hospital [Emergency Medical Services (EMS) data] form and the post-
discharge follow-up form. This means that for each record, you will begin entering the in-hospital
data then have the option to enter data for the pre-hospital patient record report (PCR) from
EMS and/or the follow-up post-discharge form.

• CDC may need to make certain updates to the PCNASP Data Collection Tool. These changes may be
needed to keep PCNASP data collection accurate and current with updated scientific guidelines and
research. Future releases and updates will be detailed on the PCNASP website.

• You will only need to do this initial setup once.

Instructions (select screenshots below): 

1. In the PCNASP webpage, click to download the file titled PCNASP Data Collection Forms.
2. The Epi Info™ XML file will begin to download. You may choose to save the file in a desired location in

your system.
3. To open and prepare the existing PCNASP Epi Info™ files and begin entering data, follow these directions

to create a project file:
a. Click the Epi Info™ icon to open the software.
b. Click Create Forms.

i. Epi Info™ will open to a blank canvas that is called the Form Designer.
c. Go to File  Click Get template.
d. Navigate to the location of the XML file (titled PCNASP_Registry_Collection_Form)
e. Click the XML file.

i. Note: The location of the folder and file will be where it is saved in your system.
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f. Click to open (or select and press OK). A dialog box should appear in the Epi Info™ canvas, 
prompting you to create a new project from template (Figure 1 below). 

g. Create a name for this project file. This project file will serve as the data collection form and the 
data collection database. 

i. Note: The name cannot start with a number or contain spaces. 
h. Note the location where the project is saved.  

i. Optional: If you would like to save this data collection form under a different location, 
click Browse and navigate to the desired folder in your system.  

ii. Note: The data repository is a Microsoft Access Database (.mdb). 
i. Click OK. 

4. The project file should then begin to load onto the canvas. Allow a few minutes for the entire project to 
load (Figure 2 below). 

5. You have just created the data collection forms for the registry (Figure 3 below). You will not be able to 
enter data in this format. Proceed with next steps to complete preparing the project files to begin 
entering data. 

 
Figure 1: New Project from Template File 
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Figure 2: Epi Info™ Loading and Creating a Project File 
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Figure 3: Project Is Loaded and Displays the First Page of the In-Hospital Form 
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How to enter data in Epi Info™ 
 
The Enter module in Epi Info™ can be used to enter new data, modify existing data, or search for records. When 
data are entered into a form, the data table inside the project is populated. The Find function allows records to be 
located based on a series of matched variables. As data are entered, the cursor moves according to the tab order 
from field to field, page to page, and saves data when navigating to a new page. If you try to exit a page before 
data are saved, you will be prompted to save the data. 

To access the Enter module and begin entering data using the PCNASP forms, follow the directions below 
(selected screenshots provided): 
 

1. If Epi Info™ is already open to the Form Designer, click Enter Data on the toolbar or select Tools > Enter 
Data. (If you are on the Epi Info™ home screen, go to step 2.) 

a. You will be prompted to create a data table. Click Yes (Figure 4 below). 
b. Create a name for the data table with a starting record ID (Figure 5 below). Click OK.  

2. If you are on the Epi Info™ home screen, click Enter Data on the main menu. Then select Open Form from 
the toolbar or File > Open Form.  

a. A dialog box to open a form will appear. Click the Ellipsis button next to the Current Project field 
to browse for a project (Figure 7 below).  

b. Select the PCNASP project file you just created (this will be a PRJ file). The project file path will 
display in the Current Project field and the PCNASP in-hospital data elements form will appear in 
the Forms field. Click OK. 

c. You will be prompted to create a name for the data table with a starting record ID (Figure 5).  
1. Enter a name for the data table.  
2. Enter a record number.  
3. Click OK. 

 
The project and form will now display with the first record in the project appearing on the canvas (Figure 6 
below). This is the in-hospital data form and should display 14 pages listed on the left, with the first page being 
Patient Information and Admission. Epi Info™ will refer to the in-hospital form as the parent form, with the nested 
pre-hospital and post-hospital forms as child forms. To navigate to the pre-hospital and post-discharge forms you 
will need to navigate to the last page in this in-hospital form (named Pre and Post data forms). You will then see 
two buttons to link you to the corresponding form. These nested forms will save the pre-hospital and/or post-
hospital data entered to the same patient record.  
 
Navigation buttons within Enter. Navigation of records is provided on the toolbar: You can use the New Record 
button and navigation buttons for next ( ), previous ( ), first ( ), and last ( ) records. You can also manually 
type the record ID number into the record list to jump to that record. When entering data into a child form (a 
nested form, like pre-hospital or post-hospital forms), use the Back button to return to the parent form (the in-
hospital form).  
 

How to save a page or record 
 
The Enter module saves data automatically as you move from page to page. Data are also saved when navigating 
to another record. You can move out of a record by tabbing out of the last field of the last page or clicking New 

A data table must be initially created before data are entered. The data table stores all records for each form in 
the project. The data table will contain record IDs.  
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Record from the toolbar to open a new record. Records can also be saved manually. There are two ways to save 
the current record manually: 

1. Click Save from the toolbar.
2. Press Ctrl+S from the keyboard.

Helpful links for additional assistance with entering data 
Navigating the Enter Workspace: https://www.cdc.gov/epiinfo/user-guide/enter-data/navigating-the-enter-
workspace.html  
Enter Data: https://www.cdc.gov/epiinfo/user-guide/enter-data/introduction.html  
How to: Find Records: https://www.cdc.gov/epiinfo/user-guide/enter-data/how-to-find-records.html  

Figure 4: Prompt to Create a New Data Table for the Project 
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Figure 5: Creating a Name for the Data Table and Starting ID 

 
 

Figure 6: Page Display When Selecting Enter Data 
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Figure 7: Opening the Data Entry Form from the Epi Info™ Home Screen 

 
 

How to view a data table 
 
In the Enter module, you can use Line Listing, located on the toolbar, to view the data table for all records that 
have been saved. Also, you can view the data in MS Excel and HTML formats. Line Listing gives you three options 
to view records (only records of the current form displayed): 

1. Interactive will display the data table in the Dashboard module. This allows you to modify and apply 
certain settings for other display options and to conduct analyses (see the Epi Info™ User Guide, section 
8, page 268, for more information on the Epi Info™ Dashboard). 

2. Printable (HTML) displays the data table for all records in the form in HTML format and will output to a 
web browser.  

3. MS Excel exports the data to an Excel spreadsheet. 
 
Remember, the pre-hospital and post-hospital forms are nested within the in-hospital form (child forms within a 
parent form). Therefore, each child form will store data in a separate data table. Using Line Listing will not display 
the records for data entered in all forms (e.g., in-hospital records along with their pre-hospital data and post-
hospital data). Viewing this linked data will need to be done in the Dashboard module, to link records across the 
three data tables (in-hospital, pre-hospital, and post-hospital).  
 
If you access the Dashboard (either from the Epi Info™ home screen or from the toolbar), the Add a Related Data 
Source option links one or more tables using a common identifier to find matching records. The form/table to be 
linked requires a key field that relates records in the two forms/tables together. The keys in the main and related 
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tables or forms do not need to have the same name. In the case of PCNASP data collection forms, you should be 
able to use the data element PatientID to link all three forms. You may also use other data elements. Follow these 
instructions to use the Dashboard to display a data table for the PCNASP forms using a common identifier: 
 

1. From the Epi Info™ 7 home screen, click Visual Dashboard (if you are in Enter with the in-hospital form 
displayed, click Dashboard and the in-hospital data table will readily load into the Dashboard—go to step 
5). 

2. Click the arrow to Set a data source now. 
3. In the dialog box, click Browse and select the PCNASP Data Collection Tool project file (from wherever you 

saved it in your system). Three forms should show up under Data Source Explorer.  
4. Select the PCNASP in-hospital form. This should begin processing in the Dashboard canvas.  
5. Right-click the canvas and select Add Related Data Source. The Select Data Source dialog box will open.  
6. Select the PCNASP pre-hospital or post-hospital form from the list of forms in the Data Source Explorer. 

The Child Key Field drop-down list will populate.  
7. From the Parent Key Field drop-down list, select PatientID.  
8. From the Child Key Field drop-down list, select PatientID.  
9. Click OK. The related form information appears on the canvas. Data from the two tables can now be used 

for analyses options within the Dashboard. 
10. To view the data table, on the top or the Dashboard, click the gray box with a down arrow and select 

Data. A data table with both linked records will display.  
11. To add another data source, follow the same directions from steps 5–10.  

 
 

How to use Find to search for records and update records 
 
Find can search for a record matching any field value or combination of field values.  
 

1. From the toolbar, select the Find icon or Edit > Find. The Find Records window will open. 
2. The Select/Unselect Search Fields list will display on the left side of the Find Records window with all 

fields contained in the form. Click a field name to select one or more fields. The selected search fields will 
turn blue and populate the gray area to the right of the list. 

3. To unselect a field, click the selected field highlighted in blue. The field will no longer be highlighted and is 
removed from the search criteria. 

4. Enter the search criteria for each field and click Search. Note that certain fields require specific formatting 
for the search criteria. If more than one field is selected, the search will display records that match all 
search criteria. This is considered an “AND” search. 

5. Open a record by double-clicking the arrow on the chosen row. The record will display in the Enter Data 
workspace. 

6. You will now be able to edit the record or enter new data for this record.  
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